
Java Desktop System Release 2
Installation Guide

Sun Microsystems, Inc.
4150 Network Circle
Santa Clara, CA 95054
U.S.A.

Part No: 817–7658–10
September 2004



Copyright 2004 Sun Microsystems, Inc. 4150 Network Circle, Santa Clara, CA 95054 U.S.A. All rights reserved.

This product or document is protected by copyright and distributed under licenses restricting its use, copying, distribution, and decompilation. No
part of this product or document may be reproduced in any form by any means without prior written authorization of Sun and its licensors, if any.
Third-party software, including font technology, is copyrighted and licensed from Sun suppliers.

Parts of the product may be derived from Berkeley BSD systems, licensed from the University of California. UNIX is a registered trademark in the U.S.
and other countries, exclusively licensed through X/Open Company, Ltd.

Sun, Sun Microsystems, the Sun logo, docs.sun.com, AnswerBook, AnswerBook2, and Solaris are trademarks, registered trademarks, or service marks
of Sun Microsystems, Inc. in the U.S. and other countries. All SPARC trademarks are used under license and are trademarks or registered trademarks
of SPARC International, Inc. in the U.S. and other countries. Products bearing SPARC trademarks are based upon an architecture developed by Sun
Microsystems, Inc. Contains Macromedia Flash Player technology by Macromedia, Inc., Copyright© 1995-2002 Macromedia, Inc. All rights reserved.
Macromedia, Flash and Macromedia Flash are trademarks or registered trademarks of Macromedia, Inc. in the United States and internationally.

The OPEN LOOK and Sun™ Graphical User Interface was developed by Sun Microsystems, Inc. for its users and licensees. Sun acknowledges the
pioneering efforts of Xerox in researching and developing the concept of visual or graphical user interfaces for the computer industry. Sun holds a
non-exclusive license from Xerox to the Xerox Graphical User Interface, which license also covers Sun’s licensees who implement OPEN LOOK GUIs
and otherwise comply with Sun’s written license agreements.

Federal Acquisitions: Commercial Software–Government Users Subject to Standard License Terms and Conditions.

DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES,
INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE
DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

Copyright 2004 Sun Microsystems, Inc. 4150 Network Circle, Santa Clara, CA 95054 U.S.A. Tous droits réservés.

Ce produit ou document est protégé par un copyright et distribué avec des licences qui en restreignent l’utilisation, la copie, la distribution, et la
décompilation. Aucune partie de ce produit ou document ne peut être reproduite sous aucune forme, par quelque moyen que ce soit, sans
l’autorisation préalable et écrite de Sun et de ses bailleurs de licence, s’il y en a. Le logiciel détenu par des tiers, et qui comprend la technologie relative
aux polices de caractères, est protégé par un copyright et licencié par des fournisseurs de Sun.

Des parties de ce produit pourront être dérivées du système Berkeley BSD licenciés par l’Université de Californie. UNIX est une marque déposée aux
Etats-Unis et dans d’autres pays et licenciée exclusivement par X/Open Company, Ltd.

Sun, Sun Microsystems, le logo Sun, docs.sun.com, AnswerBook, AnswerBook2, et Solaris sont des marques de fabrique ou des marques déposées, ou
marques de service, de Sun Microsystems, Inc. aux Etats-Unis et dans d’autres pays. Toutes les marques SPARC sont utilisées sous licence et sont des
marques de fabrique ou des marques déposées de SPARC International, Inc. aux Etats-Unis et dans d’autres pays. Les produits portant les marques
SPARC sont basés sur une architecture développée par Sun Microsystems, Inc. Inclue la technologie Macromedia Flash Player de Macromedia, Inc.,
Copyright© 1995-2002 Macromedia, Inc. Tous droits réservés. Macromedia, Flash et Macromedia Flash sont des marques de fabrique ou des marques
déposées de Macromedia, Inc. aux Etats-Unis et dans d’autres pays.

L’interface d’utilisation graphique OPEN LOOK et Sun™ a été développée par Sun Microsystems, Inc. pour ses utilisateurs et licenciés. Sun reconnaît
les efforts de pionniers de Xerox pour la recherche et le développement du concept des interfaces d’utilisation visuelle ou graphique pour l’industrie
de l’informatique. Sun détient une licence non exclusive de Xerox sur l’interface d’utilisation graphique Xerox, cette licence couvrant également les
licenciés de Sun qui mettent en place l’interface d’utilisation graphique OPEN LOOK et qui en outre se conforment aux licences écrites de Sun.

CETTE PUBLICATION EST FOURNIE “EN L’ETAT” ET AUCUNE GARANTIE, EXPRESSE OU IMPLICITE, N’EST ACCORDEE, Y COMPRIS DES
GARANTIES CONCERNANT LA VALEUR MARCHANDE, L’APTITUDE DE LA PUBLICATION A REPONDRE A UNE UTILISATION
PARTICULIERE, OU LE FAIT QU’ELLE NE SOIT PAS CONTREFAISANTE DE PRODUIT DE TIERS. CE DENI DE GARANTIE NE
S’APPLIQUERAIT PAS, DANS LA MESURE OU IL SERAIT TENU JURIDIQUEMENT NUL ET NON AVENU.

040824@9495



Contents

Preface 5

Part I Linux Systems 9

1 Before You Install the Java Desktop System on Linux 11

System Requirements 11

Dual Booting 12

2 Installing the Java Desktop System on Linux 13

Installing the Java Desktop System From CD 13

Updating an Existing System From CD 17

Installing from the Network 18

Setting up a Network Installation Repository From ISO Images 18

Network Installation From ISO Images 19

Network Installation Procedure 19

Guidelines for Partitioning 21

Resizing Your Partition 21

Creating a Custom Partition Table 22

Part II Solaris Systems 23

3 Installing the Java Desktop System on Solaris Systems 25

System Requirements 25

Installing the Java Desktop System From DVD 26

3



Downloading the Java Desktop System Installer from the Network 27

To Decompress and Extract the Installer 27

To Install the Java Desktop System 28

Part III Post Installation 29

4 After You Install the Java Desktop System 31

Checking for and Installing System Updates 31

Configuring the Xorg Xserver 31

Configuring the Xorg Xserver on Solaris Systems 32

Configuring the Xorg Xserver on Linux Systems 32

4 Java Desktop System Release 2 Installation Guide • September 2004



Preface

The Java Desktop System Release 2 Installation Guide provides installation information for
the following Sun™ Java™ Desktop System releases:

� Java Desktop System Release 2 on Linux.

� Java Desktop System Release 2 for the Solaris™ 9 Operating System 9/04 on x86
platforms.

Who Should Use This Book
This book is for users who need to install the Java Desktop System Release 2 on the
following platforms:

� Linux Systems
� Solaris OS 9/04 for the x86 platform

How This Book Is Organized
This book is organized as follows:

� Part I

Read this part for information about how to install the Java Desktop System
Release 2 on Linux.

� Part II

Read this part for information about how to install the Java Desktop System
Release 2 for the Solaris 9 Operating System 9/04 on x86 platforms.
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� Part III

Read this part for information about post installation activities that you can
perform after installing the Java Desktop System Release 2 on Linux and on the
Solaris Operating System.

Related Documentation
The following manuals are related to this guide:

� GNOME 2.2 Desktop on Linux User Guide
� Java Desktop System Release 2 Accessibility Guide
� Java Desktop System Release 2 Administration Guide
� Java Desktop System Release 2 Quick Start User Guide
� Java Desktop System Release 2 Release Notes
� Java Desktop System Release 2 Troubleshooting Guide
� Java Desktop System Release 2 User Guide
� Java System Update Service User’s Guide

You can access these manuals on the accompanying software media, and at
http://docs.sun.com.

Associated Documentation
The following manuals are associated with this guide:

� Java Desktop System Release 2 Ximian Evolution 1.4 User Guide
� StarOffice 7 Office Suite Administration Guide
� StarOffice 7 Office Suite Basic Guide
� StarOffice 7 Office Suite Setup Guide
� StarOffice 7 Office Suite User’s Guide
� System Configuration Manager, Release 1

You can access these manuals on the accompanying software media, or at
http://docs.sun.com.
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Accessing Sun Documentation Online
The docs.sun.comSM Web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. The URL is http://docs.sun.com.

Ordering Sun Documentation
Sun Microsystems offers select product documentation in print. For a list of
documents and how to order them, see “Buy printed documentation” at
http://docs.sun.com.

Typographic Conventions
The following table describes the typographic changes used in this book.

TABLE P–1 Typographic Conventions

Typeface or Symbol Meaning Example

AaBbCc123 The names of commands, files, and
directories; on-screen computer output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with
on-screen computer output.

machine_name% su

Password:

AaBbCc123 Command-line placeholder: replace with
a real name or value.

To delete a file, type rm
filename.

AaBbCc123 Book titles, new words, or terms, or
words to be emphasized.

Read Chapter 6 in User’s Guide.

These are called class options.

You must be root to do this.
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Mouse Usage Conventions
The following table lists the conventions for mouse usage in documentation for the
Java Desktop System.

Action Definition

Click Press and release the left mouse button, without moving
the mouse.

Click-and-hold Press and do not release the left mouse button.

Left-click Same as click. Left-click clarifies the action when there
might be confusion with right-click.

Middle-click Press and release the middle mouse button, without
moving the mouse.

Right-click Press and release the right mouse button, without moving
the mouse.

Double-click Press and release the left mouse button twice in rapid
succession without moving the mouse.

Drag Click-and-hold a mouse button, then move an object. For
example, you can drag a window or an icon. The left and
middle mouse buttons can perform drag actions.

Drag-and-drop Click-and-hold a mouse button, then move an object. For
example, you can drag-and-drop a window or an icon.
Release the mouse button to place the object in a new
location.

Grab Point to an item that you can move, and click-and-hold on
the mouse button. For example, you can grab the titlebar of
a window, then drag the window to a new location.

8 Java Desktop System Release 2 Installation Guide • September 2004



PART I

Linux Systems

This part contains the following chapters:

� Chapter 1

Read this chapter for information about what you need to do before you install the
Java Desktop System Release 2 on Linux.

� Chapter 2

This chapter describes the installation procedure for the Sun Java Desktop System
Release 2 on Linux.
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CHAPTER 1

Before You Install the Java Desktop
System on Linux

This chapter provides information about what you need to do before you can install
the Java Desktop System Release 2 on Linux.

System Requirements
To complete the installation you require the following:

� A PC meeting the following minimum specifications:

TABLE 1–1 System Requirements for the Java Desktop System Release 2 on Linux

Recommended Minimum

Processor Pentium III, compatible PC 600 MHz Pentium II, compatible PC 266 MHz

Hard Disk 6 GB 4 GB

RAM 256 MB 128 MB

Display
Resolution

1024 x 768 800 x 600

The PC must be capable of booting directly from the installation CD. The process of
booting from the CD varies between systems. Consult the documentation provided
with your PC if you have any difficulty.

You need to provide the following information for your PC:

� Username
� Network configuration information
� Disk partition information
� ISP configuration information
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Allow at least 45 minutes for the installation. If your system appears to hang during
the installation procedure, do not interrupt the installation process.

Dual Booting
You can create a dual boot on your PC during the installation of the Java Desktop
System.

Most factory-installed Windows installations take up all the space on your hard disk,
leaving no space for installing Linux. Therefore, the Java Desktop System installation
configurator (Configurator) creates a partition where you can install the Linux
operating system.

Every operating system has a specific type of file system, and other operating systems
often cannot read from these file systems. The Configurator can read the FAT32 file
system that is used by Windows.

Since Linux needs to have specific partitions and Windows does not have the ability to
resize partitions, the Configurator checks your hard disk and proposes an appropriate
partition setup.

Note – You can also create a specific custom partition in the event that your existing
Windows supports an NTFS file system. The Configurator does not enable you to
resize your partition in this case and proposes to replace your existing partition.
However, you can use third-party partition applications to resize your partitions if you
want to retain your Windows partition.

If you intend to create a dual boot system, consider the following:

� Back up any files that you want to keep on to a CD.
� Determine if your Windows installation uses a FAT 32 file system.
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CHAPTER 2

Installing the Java Desktop System on
Linux

This chapter describes the installation procedure for installing the Java Desktop
System Release 2 on Linux.

Installing the Java Desktop System From
CD
This section describes how to install the Java Desktop System using the CDs included
with your Java Desktop System installation package.

Perform the following steps:

1. Insert CD 1 into the CD drive.

The system starts to boot and displays the following list of options:

� Boot from hard disk
� Installation
� Installation — ACPI Disabled
� Installation — Safe Settings
� Manual Installation
� Rescue System
� Memory Test

2. To perform a new installation of the Java Desktop System, use the arrow keys to
highlight the Installation option, then press Enter.

3. The Configurator presents a Software Evaluation Agreement dialog. Click on
Accept to continue with the installation. You cannot continue with the installation
if you do not click on Accept.

4. From the Language Selection dialog, select a language, then click on Accept.
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5. The Configurator analyzes your system. If Linux is not installed on your system,
the Configurator displays the installation settings of your hardware, as shown in
the example in Step 8.

However, if the Configurator detects that Linux is installed on your system, you
are presented with the following options:

� New installation

Select this option if Linux is not installed on your system or if you want to
replace an installed version of Linux.

� Update an existing system

Select this option if you want to upgrade an installed version of Linux. This
option preserves configuration settings from your existing system whenever
possible.

� Boot installed system

Select this option if you have an installed version of Linux that you cannot
reboot. You can use this option to try to fix the reboot problem manually.

� Abort Installation

Select this option if you want to abort the installation.

6. Select New installation and click OK.

7. The Configurator displays the following Software Options:

Default system with StarSuite - for Japan, China, Korea and Taiwan only

Default system with StarOffice - for all other countries

Select the appropriate option and click on Accept.

8. Next, you are presented with the Installation settings for your system.

For example:

� Mode — New Installation

� Keyboard Layout — English US

� Mouse — PS/2 Mouse (Aux-port)

� Partitioning — Format partition /dev/hda6 9.3 GB with reiser and
Format partition /dev/hda5 196 MB for swap

If you click on Partitioning to modify the default settings, the Configurator
checks your hard disk and displays the following options:

� Accept proposal as-is
� Base partition setup on this proposal
� Create custom partition setup

Select Accept Proposal as is and click on Next.
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Note – If you want to create a dual boot system, partitioning is an essential part
of the installation procedure. Please see “Guidelines for Partitioning” on page 21
for more information.

� Software

� Default system with StarOffice - for all other countries
� GNOME system
� StarOffice
� Help and Support Documentation
� Graphical Base System

If you click on Software, the Configurator displays the following software
options:

Default system with StarSuite - for Japan, China, Korea and Taiwan only

Default system with StarOffice - for all other countries

Select the appropriate option and click on Accept.
� Booting — Booting from 1.IDE 9 54 GB, dev/hda Booting from 1.IDE 9

54 GB, dev/hda

If you click on Booting, the Configurator displays the following boot options:

� Write GRUB to the boot disk (MBR on /dev/hda)

� Create a boot floppy

� Do not use GRUB (a different boot manager is required)

� Write GRUB to a different partition: /dev/hda

Select the appropriate option and click Accept.

Alternatively, accept the booting option proposed by the Configurator.
� Time Zone —Europe — Dublin

� Language — English US

Note – You have the following courses of action at this stage in the installation
procedure:

� Click on Accept to continue with the installation.
� Click on Change to modify the installation settings before you proceed with the

installation.
� Click on Abort Installation to abort the installation.

9. Click on Accept to continue with the installation.
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10. Click on Yes, install to commit the installation and all the choices made so far.

A message informs you that the Configurator is preparing your hard disk. When
the installation begins, a screen is displayed with the following panes:

� Current Package

Displays the name, description and size of the installation package and a status
bar showing percentage completion of the installation.

� Installation

Displays the status of the percentage download completed from the CD and the
estimated time remaining to complete the download.

� Installation Log (Extract)

Displays a log of activity for all the packages currently being installed on your
system. When the download of the packages from CD 1 is complete, the
Configurator displays a message informing you that the basic installation is
finished and the system continues to reboot.

After the system reboots, a dialog requests you to insert CD 2.

11. Insert CD 2 and click OK.

When the packages from CD 2 are installed, a dialog requests you to insert CD 3.

12. Insert CD 3 and click OK.

When all the packages from CD 3 are successfully installed, the Configurator
prompts you to enter a password for root, the system administrator.

Note – Make a note of the root password for future references. You only need to log
in as root for system administration purposes.

13. Enter a password for the root user.

14. Reenter the password for verification and click on Next.

You are then prompted to add a new user. This option is optional in a network
environment.

15. Enter the First name, Last name, User login, and Password for the user you want
to add and click on Next. A new user account is created with the details you enter.

The Configurator starts to initialize the Desktop Settings as follows:

� Text mode only — no graphical desktop
� Graphical desktop environment

16. Select the Graphical desktop environment and click on Accept.

For a standalone non-networked installation, the Configurator tries to detect local
printers only.

17. Click Yes if you have a local printer attached to your system. Otherwise, click on
Skip detection.
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The Configurator writes the system configuration and displays the Installation
Settings for the following hardware devices:

� Network interfaces
� Printers
� Modems
� ISDN adapters
� Sound

18. To change any of the Installation Settings, click on Change. Click on Next to
accept the settings.

A message is displayed that the configuration is saved successfully and the system
automatically reboots.

19. Eject CD 3.

20. At the login screen, log in with the username and password that you set up for the
new user.

You can now use the Java Desktop System.

The following desktop objects are displayed:

� This Computer

� Documents

� Network Places

This object is not available in the Java Desktop System Release 2 for the x86
platform edition of the Solaris Operating System.

� Trash

� Learn About The Java™ Desktop System

� StarOffice

� Bottom Edge Panel

Refer to the Java Desktop System Release 2 User Guide for help to get you started using
the Java Desktop System on a Linux system.

Updating an Existing System From CD
If the Configurator detects that Linux is installed on your system, you are presented
with the following options:

� New installation
� Update an existing system
� Boot installed system
� Abort Installation
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If you want to upgrade an installed version of Linux, perform the following steps:

1. Select Update an existing system

This option preserves configuration settings from your existing system whenever
possible.

2. Select Create a backup if you want to make a backup of your existing system.

3. Click Next.

4. You are prompted to choose the type of upgrade you require.

5. Follow the online instructions to complete the update of your existing system as
described in “Installing the Java Desktop System From CD” on page 13.

Installing from the Network
You can perform a network installation of your Java Desktop System on Linux
platforms. Ensure you have access to an NFS shared directory that has approximately
2.5 GB of free space.

Setting up a Network Installation Repository From
ISO Images
The following sample procedure describes how to set up a network installation
repository from ISO images for the Java Desktop System on Linux:

1. Log in as root and create a directory to place the NFS image. For example, mkdir
/export/jdsimage

2. Share the /export/jdsimage directory over NFS by inserting a line in
/etc/exports. For example, enter /export/jdsimage (ro)

3. Enter /etc/init.d/nfs restart to restart the NFS server.

4. Create a directory to mount the ISO images temporarily while you copy the files,
for example mkdir /mnt/iso

5. For each ISO image, do the following:

� mount -o loop isofile.iso /mnt/iso

� Copy all the files as follows:

cd /mnt/iso

tar cf - . | cat | (cd /export/jdsimage && tar xbf 1 - )

� Unmount the ISO image as follows:

cd /
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umount /mnt/iso

Repeat step 5 for all the ISO images.

Network Installation From ISO Images
Before you begin installing the Java Desktop System from the network, you need to
have the following:

� IP address of your machine
� IP address of a nameserver
� IP address of an NFS server
� Network subnet mask
� Type of network card installed
� Three boot disks

Boot Disks
You must have three boot disks before you start the installation from the network
installation. The boot disks are available from the following:

� On disk labelled CD1 included with your Java Desktop System installation
package.

� From your network install image in the boot folder.

The boot disks are named as follows:

� bootdisk
� modules1
� modules3

Use the following command to make other disks, if required:

dd if=/export/suseimage/boot/bootdisk of=/dev/fd0

Note – You may need additional disks depending on your hardware, for example, SCSI
controllers and USB drives.

Network Installation Procedure
The following procedure describes how to perform a network installation from ISO
images on Linux systems.

1. Insert bootdisk in your drive to boot your machine.

Chapter 2 • Installing the Java Desktop System on Linux 19



The system starts to boot and displays the following list of options:

� Boot from hard disk
� Installation
� Installation — ACPI Disabled
� Installation — Safe Settings
� Manual Installation
� Rescue System
� Memory Test

Choose Installation from the menu and after a few moments, you are prompted to
insert modules1.

2. Eject bootdisk and insert modules1, then press Return.

The following prompt is displayed: "Please make sure that modules1 is
in your drive!"

3. Choose Back → English → Kernel modules (hardware drivers) Load network card
modules

You are prompted to insert modules3.

4. Eject modules1 and insert modules3, then press Return.

5. Choose your network card.

6. Enter none when you are prompted for parameters.

After a few seconds, the following prompt is displayed: Module <name> loaded
successfully

7. Choose Back → Start Installation/system → Start Installation/update → Network
→ NFS

8. Enter none when you are prompted for DHCP parameters.

9. Enter the IP address of your machine.

10. Enter a subnet mask, for example, 255.255.255.0

11. Enter a gateway for the subnet.

12. Enter the IP address of the nameserver.

13. Enter the IP address of the NFS server. The NFS server is the machine on which
you created the network install image.

14. Enter the subfolder /path/to/nfs/install/from that you previously created
on the NFS server (see “Setting up a Network Installation Repository From ISO
Images” on page 18).

15. Follow the remaining online installation instructions to complete the Java Desktop
System network installation procedures.
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Guidelines for Partitioning
The following table contains recommended guidelines for partitioning your disk:

TABLE 2–1 Guidelines for Partitioning

Partition Size Type Notes

/ 5 GB, 3 GB
minimum

Primary Install the entire Java Desktop System
operating system onto a single partition.
This method provides sufficient space for
you to install a later releases of the Java
Desktop System without the need to
repartition the disk.

swap Double the size
of RAM 128 MB
minimum

swap You can increase or reduce the size of the
swap partition as necessary.

Resizing Your Partition
The Configurator presents the following options when resizing your partition:

� Accept proposal as-is
� Base partition setup on this proposal
� Create custom partition setup

Perform the following steps to resize a partition:

1. From the Installation Settings dialog, select Partitioning, select Base partition
setup on this proposal option, then click on Next.

2. Highlight the partition that you want to resize, then click on Resize.

3. Use the slider to set how much space you want to allocate to your Windows
partition and your Linux partition, then click OK.

Note – The minimum allocation of space for Linux is 3024 MB.

4. Click on Next to save the partition table and return to the Installation Settings
screen.
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Creating a Custom Partition Table
If the partition recommended by the Configurator is unsuitable for the Java Desktop
System installation, you might need to create a custom partition table.

Perform the following steps to create a custom partition table:

1. Back up any files you want to keep. This procedure overwrites your existing
windows partition.

2. From the Installation Settings dialog, select Partitioning, select Create custom
partition option, then click Next.

3. Select Custom partitioning, for experts option, then click Next to launch the
Expert Partitioner dialog.

4. Select the device that refers to the disk where you want to install the application,
for example /dev/hda, then click Delete to erase all partitions on that disk.

5. Click Create to create a new partition and select the Primary option.

6. In the pop-up window, set the Start Cylinder size to 0, set the End Cylinder size to
+ 5 GB and set the Mount Point to / .

7. Click Create to create a new partition and select the Extended option.

The pop-up window must contain all the correct settings. For example, the Start
Cylinder value must be one more than the End Cylinder value of hda1 and the
End Cylinder value can be the same as the End Cylinder value for /dev/hda.

Creating an extended partition that covers the remainder of the disk forces all other
partitions to be created within that extended partition.

8. Click Create to create a new partition.

9. Select Swap from the menu beneath the Format option.

10. Specify the size of the swap partition using the + syntax in the End field. For
example, if your system has 256 MB RAM, you would have 512 MB of swap
memory, which is expressed as + 512 MB.

11. Click Create to create a new partition. A new partition to occupy the remainder of
the disk is configured. Set the Mount Point to /usr.

12. Click Next to save the partition table and return to the Installation Settings screen.
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PART II

Solaris Systems

This part contains the following chapter:

� Chapter 3

This chapter describes how to install the Java Desktop System Release 2 for the
Solaris 9 Operating System 9/04 on x86 platforms.
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CHAPTER 3

Installing the Java Desktop System on
Solaris Systems

This chapter describes the installation procedure for installing the Java Desktop
System Release 2 for the Solaris 9 Operating System 9/04 on x86 platforms.

System Requirements
Table 3–1 lists the system requirements to install the Java Desktop System Release 2 on
the Solaris Operating System:

TABLE 3–1 System Requirements for the Java Desktop System Release 2 for the Solaris
Operating System

System Parameter Requirement

Operating System Solaris 9 Operating System 9/04 on x86 platforms.

Hardware Java Desktop System Release 2 for the Solaris 9 Operating
System 9/04 on x86 platforms runs on the following hardware
systems:
� Sun Java Workstation W1100z
� Sun Java Workstation W2100z

Disk Space � You need up to 2.0 GB free space if you are installing the
Java Desktop System from DVD.

� If you are downloading the Java Desktop System Installer
from the network, you require a further 2.8 GB free space to
download and to extract the Installer tar files.

Memory 128 MB per user session.
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Installing the Java Desktop System From
DVD
This section describes how to install the Java Desktop System from the product DVD.

Note – You must first install the Solaris 9 Operating System 9/04 on x86 platforms on
your Sun Java Workstation W1100z or Sun Java Workstation W2100z.

Perform the following steps:

1. Log in as root as follows:

From the Login screen, choose Options → Sessions → Common Desktop
Environment (CDE).

2. Once you are logged in, open the DVD tray, insert the product DVD, then close the
DVD tray.

After a few seconds, the DVD file manager is displayed.

Note – If the DVD file manager window fails to open, perform the following steps:

� From the CDE Front Panel, choose File → Removable Media Manager.
� Double-click on the DVD icon to open the file manager.

If the file manager fails to open, you may need to stop and restart Volume
Management. Enter the following commands:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

3. Double-click on the JavaDesktop folder.

4. Double-click on install-jds icon in the JavaDesktop folder.

5. Follow the on-screen instructions to view the license.

6. Type accept in the current UI language at the prompt. If you do not type accept,
you cannot continue with the installation.

The installer checks your system and then begins to install the Java Desktop
System, Release 2 software.

7. When the installation is complete, choose File → Eject and close the installer
terminal window.

8. Reboot your workstation.
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9. From the Login screen, choose Options → Sessions → Java Desktop System,
Release 2 to log into the Java Desktop System.

Downloading the Java Desktop System
Installer from the Network
Perform the following steps to download the installer for the Java Desktop System
from the network:

1. Ensure that you have enough disk space for the download and the installation.

2. Decide which directory you want to download the installer to. You must install the
desktop as a root user, therefore the download directory must be accessible by a
root user.

3. Open the following web page in your browser:
http://www.sun.com/software/javadesktopsystem/index.html

The instructions on the download site inform you how to do the following:

� Download the appropriate set of tarball chunks for your country.
� Reassemble the tarball chunks into the compressed tarball.
� Run the install script from a command line as a root user.

4. Click on the Download Now link for the required installer in the Download
section of the page.

5. Log in if you are an existing download user, or go to the registration page if you
are a new user.

6. Read the Terms of Use page, select Accept, then click Continue.

7. From the Download page, click on the description of the tarball that you want to
download.

8. Download the tar file for the installer from the Sun Download Center to a directory
accessible by the root user.

To Decompress and Extract the Installer
Perform the following steps to decompress and extract the installer:

1. Log in as root to CDE, then open a terminal window.

2. Use the cd command to change to the directory to which you downloaded the tar
file for the installer.

Chapter 3 • Installing the Java Desktop System on Solaris Systems 27

http://www.sun.com/software/javadesktopsystem/index.html


3. Execute the following command to decompress and extract the installer:

gunzip -c jds-2_0-fcs-solaris9-x86.tar.gz | tar xvpf -

4. When the installer is fully extracted, you can delete the downloaded file to free up
disk space. Execute the following command to remove the installer:

rm jds-2_0-fcs-solaris9-x86.tar.gz

To Install the Java Desktop System
The installation script replaces old versions of the following products with newer
versions included in the Java Desktop System:

� GNOME Desktop
� Netscape
� Mozilla
� Java Media Framework
� StarOffice

The installation script also replaces the installed version of Java 1.4.2 if that version is
older than the version included in the Java Desktop System.

Note – The Java Desktop System installation changes your system. Backup your
system now. If you want to revert your system back to the original state, you must
perform a new Solaris installation. An upgrade installation does not recover your
system back to the original state.

To install the Java Desktop System, perform the following steps:

1. Log in as root to CDE, then open a terminal window.

2. Use the cd command to change to the jds-2_0-fcs-solaris9-x86 directory.

3. Run the following command to start the installation:./install-jds

4. Follow the instructions that appear on your screen. Respond to all prompts and
follow through the installation decisions that you need to make.

5. Type accept in the current UI language at the prompt when the installation script
displays the license agreement. If you do not type accept, you cannot continue
with the installation.

6. When the installation is complete, reboot your system if the installation script
notifies you to do so.
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PART III

Post Installation

This part contains the following chapter:

� Chapter 4

This chapter describes activities that you can perform after you install the Java
Desktop System Release 2.
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CHAPTER 4

After You Install the Java Desktop
System

This chapter describes post-installation procedures that you can perform after you
install the Java Desktop System Release 2.

Checking for and Installing System
Updates
The Java System Update Service (Java SUS) enables you to perform the following
actions:

� Install software updates for your Java Desktop System.
� Choose which updates to install from a list of available updates.
� Specify which server to check for available updates.

To launch the Java SUS application, choose Launch → Applications →Utilities
→Online Update.

Refer to the Java System Update Service User’s Guide for more information. This guide is
available on the accompanying software media, and at http://docs.sun.com.

Configuring the Xorg Xserver
Before you start to configure your Xorg Xserver, you need to know the following:

� Type of keyboard, for example, Sun Type 6 UK.

� Mouse device, for example, /dev/usb/hid1.
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� Graphics adapter, for example, the model of your graphics adapter and the amount
of video RAM.

� Specification of the monitor.

Configuring the Xorg Xserver on Solaris Systems
To configure the Xorg Xserver for the Solaris 9 Operating System 9/04 on x86
platforms, perform the following steps:

1. Log in as root to a command line Login session.

2. Run the following command to start the Xorg Xserver
configuration:/usr/X11R6/bin/xorgconfigure

3. Follow the instructions that appear on your screen. Respond to all prompts and
follow through the configuration decisions that you need to make.

You can reconfigure the Xserver back to its default values as follows:

1. Log in as root to a command line Login session.

2. Execute the following command:/usr/X11R6/bin/X -xconfigure

3. Copy the generated /xorg.conf.new file to /etc/X11/xorg.conf as follows:
cp /xorg.conf.new /etc/X11/xorg.conf

Configuring the Xorg Xserver on Linux Systems
Use the YaST2 configuration tool for configuring the Xorg Xserver on Linux systems.

32 Java Desktop System Release 2 Installation Guide • September 2004


	Java Desktop System Release 2 Installation Guide
	Preface
	Who Should Use This Book
	How This Book Is Organized
	Related Documentation
	Associated Documentation
	Accessing Sun Documentation Online
	Ordering Sun Documentation
	Typographic Conventions
	Mouse Usage Conventions

	Linux Systems
	Before You Install the Java Desktop System on Linux
	System Requirements
	Dual Booting

	Installing the Java Desktop System on Linux
	Installing the Java Desktop System From CD
	Updating an Existing System From CD
	Installing from the Network
	Setting up a Network Installation Repository From ISO Images
	Network Installation From ISO Images
	Boot Disks

	Network Installation Procedure

	Guidelines for Partitioning
	Resizing Your Partition
	Creating a Custom Partition Table


	Solaris Systems
	Installing the Java Desktop System on Solaris Systems
	System Requirements
	Installing the Java Desktop System From DVD
	Downloading the Java Desktop System Installer from the Network
	To Decompress and Extract the Installer
	To Install the Java Desktop System


	Post Installation
	After You Install the Java Desktop System
	Checking for and Installing System Updates
	Configuring the Xorg Xserver
	Configuring the Xorg Xserver on Solaris Systems
	Configuring the Xorg Xserver on Linux Systems




